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Using 
DDDL 

7.0 
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2007 Electronic Tools for DDEC VI

I. The 2007 Electronic 
Tools Family of 

Products
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2007 Electronic Tools for DDEC VI

3 Different Electronic Tools will be 
created from 1 main software package

Current Product 2007 Product Equivalent

DDDL Detroit Diesel Diagnostic Link 7.0 
(Customer Level – simple registration program)

DRS Detroit Diesel Reprogramming System (Service 
Level – requires hardware key and DRS ID for 
programming functions)

DDC Cal Tools Drumroll (Engineering / Plant Level only–
advanced access key registration)
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2007 Electronic Tools for DDEC VI

Operations for 2007 Electronic ToolsOperations for 2007 Electronic Tools
1- Perform Standard Fault Code Operations
2- Links to Traditional and Advanced  
Troubleshooting Information
3- Read Actual Values 
4- Configure and Manage Parameters
5- Perform Service Routines
6- Playback Logs of All Connected Activity
7- Programming Capability for the CPC / MCM 
(DDRS only with reprogramming station hardware 
key and ID)
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2007 Electronic Tools for DDEC VI

The DDC 2007 electronic tools are written to the new DCX standard.  
The new standard calls for the diagnostic tools to be “data driven” by 
the ECU.

With this approach the primary diagnostic functions are contained in the 
ECU software with the tool serving as the gateway to these functions. 
The CBF file serves as the tool’s gateway to the functionality of the ECU. 
Updates to the new electronic tools may often be done through web 
downloads of a new CBF file rather than the release of new CDs. 
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2007 Electronic Tools for DDEC VI

There will be two types of updates for the 2007 
electronics tools:  

CD updates: 

1- Will be required when 
major changes to the 
program occur, such as 
changes to the graphical 
user interface

Web based updates: 

1- Download new CBF files 
that will allow the user to 
work with new levels of ECU 
software and add 
functionality to the tool

2- New cases for Advanced 
Diagnostics as they are 
developed from field 
experience

3- Other data based update



©
20

06
 D

et
ro

it
 D

ie
se

l C
or

po
ra

ti
on

 a
nd

 T
ec

hn
ic

al
 S

up
po

rt
.  

A
ll 

Ri
gh

ts
 R

es
er

ve
d.

 F
ile

na
m

e/
6/

6/
20

08

7

2007 Electronic Tools for DDEC VI

II. Understanding 2007 
Hardware and 

Communications
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2007 Electronic Tools for DDEC VI

1- All DDEC electronics systems prior to DDEC VI used the J-1587 
(messaging) / J-1708 (hardware) standards for all diagnostic and data 
communications. 

2- All diagnostic software and translator hardware devices conform
to the RP1210A communications standard of The Maintenance 
Council (TMC).

3- The DDEC VI system will now use the J-1939 (messaging) / CAN 
(hardware) standards for diagnostic communications. 

4- DDEC VI Data Communications will continue to use the J-1587 
(messaging) / J-1708 (hardware) standards.

5- DDEC VI software and translator hardware devices will continue to 
conform to the RP1210A standard.
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2007 Electronic Tools for DDEC VI

Translator Box Hardware for DDEC VI Diagnostics

1- Translator box hardware for 2007 diagnostics must 
support CAN communications.

2- The Nexiq USB Link, the Nexiq Magic Key, and the DDC 
Multi-link translator boxes may all be used with 2007 
diagnostic software. 

3- The Multi-link will need a firmware update to function 
properly

4- The Nexiq Lite-link and DDC White translator do not 
support CAN communications and may not be used.
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2007 Electronic Tools for DDEC VI

Additional Information on 2007 Electronics 
Communications  

1- For data extractions (DDEC Reports) all the translator 
devices on the last page may be used as well as J-1708 
devices like the Nexiq Lite-link.

2- The Nexiq USB Link will be the translator device for 
programming DDEC VI modules (MCM and CPC). The 
USB Link will also be fully backward compatible with 
programming earlier DDEC modules in 1st Quarter 2007.

3- DDC electronic tools software may only be used with 
the Windows 2000 or Windows XP operating systems.
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2007 Electronic Tools for DDEC VI

III. 2007 Electronic 
Tools Basics
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2007 Electronic Tools for DDEC VI

Understanding the 2007 Launcher Utility 
The Detroit Diesel Electronic Tools Suite
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2007 Electronic Tools for DDEC VI

The Detroit Diesel Electronic 
Tools Suite is a utility designed 
to assist the user in 
determining the version of 
DDDL to use with a particular 
engine. 

It monitors the J-1708 
diagnostic bus for specific 
engine information and 
indicates the programs that 
may be used.
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2007 Electronic Tools for DDEC VI

When running this program 
for the first time please click 
on the “About” box from 
main screen and review 
important information about 
how the program operates.
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2007 Electronic Tools for DDEC VI

The next step is to configure the 
type of translator box you’ll be 
using with the program. Choose 
the “Configure” box from the 
main screen of the utility and 
you’ll be able to select from the 
same list of translators 
available for DDEC Reports. 
Make a selection from the list 
and choose “OK”. You are now 
ready to use the program.
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2007 Electronic Tools for DDEC VI

When connected through the 
vehicle diagnostic connector and 
the ignition is switched on the 
utility will automatically detect 
the type of module you are 
connected to and highlight the 
programs that may be used with 
this system by drawing a green 
border around them. You may 
launch the program by clicking 
inside the green area.

Note: The program will present 
additional program choices 
when loaded with the Detroit 
Diesel Programming Software, 
however the underlying details 
of the program are identical. 
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2007 Electronic Tools for DDEC VI

Opening DDDL 7.0
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2007 Electronic Tools for DDEC VI

After the application has been successfully installed and the 
translator configured, you may access it from the Launcher utility 
or the icon that gets installed on your Windows desktop.

The DDDL 
application 
screen will 
appear as the 
software loads
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2007 Electronic Tools for DDEC VI

The registration  screen will appear before the program loads 
completely.  Please check the registration process document 
on the CD for details on registering your software. 
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2007 Electronic Tools for DDEC VI

You’ll need to acknowledge the safety message to finish loading the 
application. We’re now ready to start using the program.
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2007 Electronic Tools for DDEC VI

Connecting Automatically
With DDDL 7.0



©
20

06
 D

et
ro

it
 D

ie
se

l C
or

po
ra

ti
on

 a
nd

 T
ec

hn
ic

al
 S

up
po

rt
.  

A
ll 

Ri
gh

ts
 R

es
er

ve
d.

 F
ile

na
m

e/
6/

6/
20

08

22

2007 Electronic Tools for DDEC VI

By default the electronic tools 
attempt to connect automatically to 
the CPC and MCM.

If the tool is connected to a live 
vehicle then the results of a 
successful connection are displayed 
in the status window in the lower left 
of your screen 

If the initial detection period elapses 
without connecting to a module 
attempts to continue making a 
connection are suspended 

You may retry the connection 
process anytime after the initial 
auto-connect phase by clicking on 
the connect button in the icon bar.
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2007 Electronic Tools for DDEC VI

Making a Manual 
Connection with DDDL and 

Viewing the Main Screen 
Components
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2007 Electronic Tools for DDEC VI

DDDL allows the user to make a manual 
connection to each controller by using the 
following procedure: From the “File” drop-down 
menu select the “Connect” option. A new box 
will appear showing a list of ECUs you may 
connect to. Highlight one of the choices and 
select “connect”

Special notes on making 
a connection: The user 
may connect to one or all 
of the modules listed in 
this window. There is no 
minimum number or 
combination of modules 
required. The user may 
re-enter the window and 
connect to other modules 
at any time.
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2007 Electronic Tools for DDEC VI

A progress bar will move quickly across the during the 
connection process.  Once the process is complete the user may 
decide to establish another connection or work with connected 
module.
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2007 Electronic Tools for DDEC VI

Main Workspace 
Area

Once the 
connection 
process is
complete the 
main window 
components 
are ready for 
use.
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2007 Electronic Tools for DDEC VI

Drumroll DDRS DDDL 7.0

In the function menu the numbers of items will vary 
depending upon the access level of the tool.
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2007 Electronic Tools for DDEC VI

IV. Identification
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2007 Electronic Tools for DDEC VI

Complete information on 
all connected modules 
appears in this section.

CPC and MCM 
information appear in 
clearly marked, separate 
sections throughout the 
application.

The other components of 
the the Identification 
window are the “Stored 
Data” tab and the Audit 
Trail” tab.
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2007 Electronic Tools for DDEC VI

In Audit Trail tab allows the 
user to track information on the 
3 most recent changes made in 
the following areas:

- General “Customer 
Parameter” changes 
- Changes made to the 
“Password Groups”
- Changes made to the “Engine 
Rating”
- Changes made to the “Real 
Time Clock”
- Specific changes made that 
effect the “Vehicle Road Speed”

The tracking of changes made 
to the passwords is new to 
DDDL. All the other groups 
were tracked in earlier versions 
of DDDL. 
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2007 Electronic Tools for DDEC VI

The “Stored Data” tab 
contains detailed information 
on the module hardware and 
software versions.for both 
the MCM and CPC. 

The fuel map part number is 
on this screen as well as 
rating information on the 
engine.
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V. Using the Fault Code Window
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2007 Electronic Tools for DDEC VI

Fault codes appear 
for each module 
appear in the main 
window when the 
you select the 
“Fault Code”
function  (2)

The “Number”
refers to the J1939 
SPN and the 
“Mode” refers to 
the J1939 FMI (3)

The “+” signs to the 
left of the fault 
codes indicate 
additional 
information on this 
code is available (4)The connection status window displays the a summary of 

active faults (1).  The status message is displayed in red if 
faults are active, black in all other cases.
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2007 Electronic Tools for DDEC VI

A sample of the 
extended fault 
code 
information 
available for 
2007 fault 
codes. The 
2007 codes 
contain much 
more 
information on 
each code than 
previous 
versions of 
DDEC. 

To view the extended data click on the “+” plus sign in front of the fault in the main 
fault code menu. To view the contents of the data in each of the records click on the 
“+” sign in form of each section. Extended records 1 through 3 contain information 
that will be of use to all technicians. Data in Extended Records 4 and 5 will be of 
interest to technical support and engineering. 
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You may copy the entire 
contents of the fault 
window and paste it to a 
different application, by 
going to “Edit” and 
choosing “Copy”.  This 
function is available in 
other windows as well. 
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2007 Electronic Tools for DDEC VI

To clear all fault 
codes go to the 
lower left of the 
window and 
choose to “Clear 
All Faults”. To 
clear a single 
code highlight the 
code you wish to 
clear and choose 
the “Clear Fault”
box.
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VI. Interactive Troubleshooting 
Material
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In the 2007 electronic tools users will be able to access 2 types of 
troubleshooting material.  

1- The first is the traditional troubleshooting material that has 
been an important part of DDDL since its initial release.

2- The Advanced Diagnostics material is being introduced for the 
first time for DDEC VI. Advanced Diagnostics will guide the user
through troubleshooting complex systems (ATS, EGR, etc.) by 
evaluating sensor data from the engine running under specific 
conditions and running diagnostic routines. Cases for Advanced 
Diagnostics will be created based on the latest engineering and 
information from the field.

3- Both types of troubleshooting information will be updated via 
Internet downloads.  



©
20

06
 D

et
ro

it
 D

ie
se

l C
or

po
ra

ti
on

 a
nd

 T
ec

hn
ic

al
 S

up
po

rt
.  

A
ll 

Ri
gh

ts
 R

es
er

ve
d.

 F
ile

na
m

e/
6/

6/
20

08

39

2007 Electronic Tools for DDEC VI

Using Traditional 
Troubleshooting Information 

in Diagnostic Link
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To access the standard troubleshooting material highlight the fault 
code you wish to work on.

Move to the lower right of the fault code window and select the 
“Troubleshooting Fault” box.
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A screen will 
appear asking 
the user to 
select the 
engine type 
being worked 
on. It is critical 
to select the 
correct engine 
type. Once the 
choice is made 
go to the 
“Next” box in 
the lower right 
of the window.
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The 
troubleshooting 
material for the 
selected fault will 
appear on the 
screen. Follow the 
steps in the guide 
using the 
hyperlinks until the 
repair is 
completed. 

The 
troubleshooting 
guide may also be 
accessed when not 
connected to the 
vehicle by 
choosing the 
“Troubleshooting”
item from the main 
function menu.
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Using Advanced Diagnostics 
Troubleshooting Information 

in Diagnostic Link
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The Advanced Diagnostics material is being introduced for the first 
time for DDEC VI. Advanced Diagnostics will guide the user through 
troubleshooting complex systems (ATS, EGR, etc.) by evaluating 
sensor data from the engine running under specific conditions and 
running diagnostic routines. Cases for Advanced Diagnostics will be 
created based on the latest engineering and information from the field.

The user will begin the advanced diagnostics 
troubleshooting process in the same manner as the 
traditional troubleshooting guide material. Select a 
fault code from the list in the fault code window and 
then go to the “Troubleshoot Fault” box in the lower 
right of the window.

Indicates traditional 
troubleshooting information is 
available for the fault

Indicates advanced diagnostics 
troubleshooting information is 
available for the fault
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The fault code SPN 2791 FMI 7 is 
displayed in the MCM fault code list.  
When the code is highlighted (1) you’ll 
note that this fault has an Advanced 
Diagnostics troubleshooting procedure. 
To proceed with the advanced procedure 
click on the “Troubleshoot Fault” box..
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A screen will 
appear asking the 
user to select the 
engine type being 
worked on. It is 
critical to select 
the correct engine 
type. Once the 
choice is made go 
to the “Next” box 
in the lower right 
of the window. 

NOTE: With later 
versions of MCM 
software this 
window will no 
longer appear 
because the 
program will auto-
detect the engine 
type.
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The next screen 
informs the user 
of how the 
diagnostic 
process will 
proceed. In this 
case the tool will 
perform a 
functional check 
of the EGR valve. 
To proceed click 
on the “Next”
box in the lower 
right.
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The next screen 
informs the user 
that the ignition is 
“ON”. To proceed 
click on the “Next 
box in the lower 
right.
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On the next 
screen the user 
sees that the 
application has 
run the MCM 
service routine 
to activate PWM 
outputs. The 
values are pre-
set for the 
routine and the 
results will 
analyzed on the 
next screens. To 
proceed click on 
the “Next” box 
in the lower 
right. 
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On the next 2 
screens we 
receive more 
information on 
what was just 
done. The 
routine 
requested that 
the valve be 
opened to a 
value of 50%. 

For further 
analysis the user 
should move to 
the next screen 
by clicking on 
the “Next” box.
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The next screen 
tells us that the 
valve opened  to 
a position within 
the tolerance of 
the value 
requested. . 

Based on this 
feedback from 
the tool we are 
prepared to 
proceed with the 
process by 
selecting the 
“Next” box.

If the value fell 
outside the 
accepted 
tolerance of the 
test the 
diagnostic 
process would 
proceed in a 
different 
direction.
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In the next 
screen the user 
is requested to 
turn off the 
ignition.

The tool will 
automatically 
detect when the 
ignition is shut 
off and will 
automatically 
switch to the 
next screen in 
the process.
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Once the ignition 
has been shut off 
the user is 
directed to 
perform specific 
physical checks 
on the EGR valve. 
When the checks 
have been 
completed one of 
the answers at the 
bottom of the 
screen should be 
selected to 
proceed.
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If the user answers 
“Yes” he’ll be 
instructed to repair the 
damage he’s observed 
and clear the fault.

If the answer is “No”
then the user should 
contact technical 
support for further 
information.

In either case, to 
proceed the user 
should click on the 
“Next” box in the 
lower right of the 
screen.
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In closing out 
the Advanced 
Diagnostics 
procedure, the 
user is asked to 
fill in comments 
on the 
troubleshooting 
process.

After this is 
section is 
completed the 
user should 
click on the 
“Next” box to 
see a complete 
report on the 
steps taken.
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A final 
summary will 
appear with 
details of the 
case. Click 
on the 
“Finish” to 
close out the 
procedure.
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VII. Understanding the 
Instrumentation 

Windows
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The Instrumentation Window
1- There are 3 main functions to this section

2- All Instruments (1) / The Chart (2) / Individual Panels (3)

3- The CPC and MCM values are listed by module in the “All Instruments” list

The values may be from either module in the “Individual Panels”

Units may be viewed in English or Metric 
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A sample shot 
of MCM values 
from the “All 
Instruments”
tab. Data 
values in the all 
instruments tab 
are arranged by 
the type of 
value being 
displayed 
(temperatures, 
pressures, etc.)
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A sample 
shot of the 
After 
Treatment 
Device 
(ATD)  tab
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A sample shot of the “Switches” tab
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The “User” tab 
allows the user 
to configure his 
own selection of 
instruments 
form any 
module he is 
connected to. 

The selection 
may also be 
saved for future 
use by clicking 
the disk icon (1) 
and providing a 
file name.

Stored 
selections may 
be opened by 
clicking on the 
folder icon (2).
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Chart Features

- Parameter list always “on-top” to select new items.

- All chart related windows are completely re-sizeable.

- Gives the user the ability to check on the scale being 
used for each parameter.

- Gives the user the ability to pinpoint a value at any point 
on the chart.

- Gives the user the ability to zoom in on a certain section 
of data
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A sample shot of the “Chart” function 
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A sample 
shot of 
reading a 
specific 
value in 
the “Chart”
function 
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To use the “Zoom In” function, mark each boundary of the zoomed area by dragging  
your mouse (1 & 2) across the area desired and then select the “Zoom In” box (3).
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VIII. Understanding the 
Logging Function
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The Logging Function
- DDDL keeps a running log of all the activity that occurs during a 

connection with an ECU. 

- The logs are stored as files on the hard drive and are available for 
playback. 

- Once a log file is opened the playback buttons in the toolbar become 
activated.

- Many DDDL functions can be used when playing back the log file 
without needing to be connected to an ECU.

- Log files may not be played if the user is connected to an ECU

- Please note that only data from connected modules will be stored in the 
log files. For example, if you have only connected to the CPC your log 
will not contain MCM data even though the engine is running.
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To play a log file choose the 
“File” drop-down menu and 
choose the “Open log” option.

A dialog box will appear 
with all the log files. It will 
open to a default folder but 
you may move to any folder 
containing logs. They are 
identified by a specific date 
/ time stamp and VIN (when 
available). Highlight the file 
you wish to open and click 
on the “Open” box.
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Once a log file has been loaded the 
playback controls in the application 
toolbar will become active and ready to 
use.  The user may identify the function 
of each control by running their mouse 
across the top of the control.

Once the “Play” button becomes active the panels will fill up with data 
that was collected during the log session. .
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Additional playback control features

You may alter the 
playback speed of 
the log file

Service routines are 
marked for easy 
identification in 
playback mode
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IX. Configuring 
Parameters for 2007 

Engines
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Important Notes on the Parameters 
Function

- The layout of the parameters is 
similar to the current MBE system 

- Values may be displayed in Metric or 
English units (units of distance, 
temperature, and volume change; 
pressure readings remain in bar 
units)

- Parameter sets may be stored as 
files for printing or sending in e-
mails using the “Export” function. 

- Immediate recycling of the ignition to 
save settings should be done to save 
ECU changes.
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When entering the  
“Parameters” section 
all the values of the 
parameters from all 
connected modules 
will be read. Progress 
will be tracked on 
screen.
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Viewing the individual values of parameters

- Parameters are placed in groups. To view the values of any parameter within 
the group the user opens and closes the folder by clicking on the “+” or “-”
in front of the group name similar to the operation in Windows Explorer.
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To change a parameter simply click into the values column. For numerical 
values simply type in the desired value. For CPC parameters with more 
than one configurable selection (as seen below), a drop-down menu will 
appear.  

When all the changes are made click on the 
“Send” box in the lower left of the window.
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As the
parameters are 
written back to 
the module a 
progress bar 
will appear 
until the 
process is 
complete. 

At this point 
you should re-
cycle the 
ignition to 
store the 
changes.
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The “Find” function allows the 
user to search the entire 
parameter list for a key word(s). 
Type in the name of a parameter 
you wish to locate.

You’ll be 
taken to the 
first location 
of that name 
in the 
parameter list
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Import / Export Function
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The Import / Export Function
- This function allows the user to work with parameter 

sets from both the CPC & MCM.
- Using the “Export” selection, parameter sets may be 

saved to the user’s hard drive, recalled, and printed out.
- The “Import” function allows the user to load a complete 

or partial parameter set to a module. The user must use 
a file with a .par extension for import purposes. 

- Users may use the “Import” function to view and edit 
par files when not connected to a live CPC or MCM.



©
20

06
 D

et
ro

it
 D

ie
se

l C
or

po
ra

ti
on

 a
nd

 T
ec

hn
ic

al
 S

up
po

rt
.  

A
ll 

Ri
gh

ts
 R

es
er

ve
d.

 F
ile

na
m

e/
6/

6/
20

08

82

2007 Electronic Tools for DDEC VI

To begin the export process enter the “Configure 
Parameters” section. After retrieving the settings, 
choose the “Export” selection from the “Parameters”
drop-down menu.

A dialog box will appear that 
allows the user to decide what 
groups of parameters should be 
exported.  By default the 
parameters checked are those that 
have settings that are different 
from those loaded at the time the 
CPC was built. 

You may use the “Select Modified”
box to clear the settings and only 
mark certain groups for export.

To undo changes that you’ve  
made you may use the “Toggle”
box.
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Once you’ve 
completed making 
your selections click 
on the “Export” box to 
continue

A new dialog box will 
appear asking for a file 
name. Give the file a 
name and then click 
on the “Save” box to 
complete the process
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To open a previously saved exported file for review or printing,
locate the file in Windows Explorer.

Click twice on 
the file and it 
will open in 
Notepad.
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To load a previously created file you must 
first enter into the “Parameters” window.  
After the parameters are read out, choose 
the “Import “ function form the 
“Parameters” drop-down menu. 

When the dialog box of previously stored files appears, choose the one you wish to 
import into the module and select “Open”. 
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After choosing the file it will need to be 
sent to the module. Choose the send 
button just as if you’ve made a parameter 
change.

You will see the progress bar moving across the screen as 
the parameters are written back to the module.

When the process is complete you will need to re-cycle the 
ignition to store the changes. 
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Understanding Security Levels for the 
Import / Export Functions 
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The feature “Access Levels Considered with Import/Export of 
Parameter Data” allows for more security on PAR files. It is not 
possible for DDC Engineers to provide a PAR file containing Level 3 
parameters to a user with Level 1 or Level 2 tools, and expect all 
parameters to be sent to a device. An error message will be provided to 
the lower level users when this is attempted. The error will list which 
parameters were not sent because of insufficient access .

Parameters will be sent to the device in this manner:

- Level 1 Tool (DDDL): only Level 1 parameters are sent to the device 
without generating an error message.

- Level 2 Tool (DDRS): Level 1 and Level 2 parameters are sent to the 
device. without generating an error message.

- Level 3 Tool (Drumroll): All parameters (Level 1, Level 2 and Level 3) 
are sent to the device without generating an error message.
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This screen shot 
illustrates an 
error message 
generated by the 
tool when a 
DDDL user (level 
1) attempts to 
import a PAR file 
which was 
exported from a 
DDRS 
application.

Please note the 
import process 
successfully 
sent all the 
parameters 
which only 
needed level 1 
access. Only the 
items listed in 
the box were not 
sent. The 
message at the 
bottom of the 
screen will be 
modified.
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Understanding Password 
Protection
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CPC Password Protection

- CPC modules containing R1 software have the ability to password
protect their settings. 

- Users may protect all their CPC settings with one general password.

- A secondary level of protection for certain parameter groups is also 
available.

- Password are 4 characters long and may consist of numbers or 
letters.

- 2007 Detroit Diesel electronic tools contain complete support for 
CPC password functions.

- The 2007 CPC password protection system has many similarities to 
the current MBE system.
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To access the password functions, 
go to the “Parameters” drop-down 
menu and choose “Configure 
Passwords”.

The main screen for 
setting and changing 
passwords will appear. 
You will also see the 
various groupings 
available for secondary 
password protection on 
this screen.
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To enter a new password 
simply enter the desired 
password and choose the 
“Send” box. When the 
operation is successfully 
completed you’ll get a 
message confirming the 
operation. . 

To change a password 
already in place you would 
go to the same screen but 
enter the old password first.
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This screen 
illustrates 
what the 
user will 
observe 
when he 
attempts to 
change a 
parameter in 
a CPC that is 
currently 
password 
protected.

The user will 
make any 
changes as 
described 
previously 
but the 
protection 
screen will 
appear after 
the “Send”
button is 
clicked.

Enter the password and click on “OK” to finish sending the change.
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For instances of lost or 
forgotten passwords 
there is a backdoor 
function which may be 
accessed through from 
the main password 
configuration screen.

To begin the process 
of unlocking a CPC 
with with an unknown 
password copy the 
“Seed” value and call 
the Customer Support 
Center (CSC) at 313-
592-5800.

Note: DO NOT close 
the original window 
where the seed value 
appears. If you close 
the window the seed 
will change.
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The CSC will require that you provide 
specific information on the particular 
circumstances of the backdoor 
request prior to releasing a backdoor 
password. This is for security and 
tracking purposes.

When you have received the backdoor 
password enter it in the proper box 
and select the “OK” box.

When the correct password has been 
entered you will receive message telling 
you that all the passwords have been 
reset.

Note: The 2007 backdoor function 
permanently clears all set passwords in 
the CPC. You will need to reset your 
chosen password levels to resume CPC 
password protection.
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X. Using the Service 
Routine Window
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Service Routines

- Service routines are 
located in both the 
MCM and CPC 
modules and cover a 
wide variety of 
functionality

- Routines may 
appear differently 
depending upon the 
level of software in 
the modules and the 
type of tool being 
used.
-Some routines have 
automatic 
implementation, 
others require 
manual 
implementation by 
the user. 
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The service 
routine window 
has 3 main 
portions.  To 
implement any 
routine make a 
selection from the 
list (1), configure 
the routine in the 
workspace (2), 
and execute the 
routine (3).

This example 
shows the how to 
write the VIN 
using the CPC 
service routine.
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A cross 
section of 
service 
routines 
available in 
the MCM 
software.
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In addition to the “All Services Tab”, The most frequently used service 
routines appear on user-friendly tabs:.

- The Injector Codes Tab

- The Rating Tab

- The Real-time Clock Tab

- The Turbo Actuator Tab

- The Activate Outputs (for both MCM & CPC) Tab

- The Compression Test Tab

- The Automatic & Manual Cylinder Cutout Test Tab

- The DPF Regeneration Tab

- The Voltage Tab (for all 3 & 5 volt sensors).



©
20

06
 D

et
ro

it
 D

ie
se

l C
or

po
ra

ti
on

 a
nd

 T
ec

hn
ic

al
 S

up
po

rt
.  

A
ll 

Ri
gh

ts
 R

es
er

ve
d.

 F
ile

na
m

e/
6/

6/
20

08

102

2007 Electronic Tools for DDEC VI

Injector Codes Panel / Production DDEC VI engine injectors will contain injector codes for optimal performance.  
This panel will allow the user to read the current values of the injectors and also allow the entry of new values 
when the injector is replaced in the shop. The user will enter the value on the of the new injector (highlighted in 
red in picture above) and then send the value to the MCM. There is built in error checking procedure to prevent 
entry errors. 
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The Rating Panel allows the user to easily manage the horsepower choices available in a 
particular fuel map. To see which of the ratings is currently selected click on the “Read Rating”
box. The rating currently selected will remain grayed out while the other two choices will be 
darkened in indicating they are available for making change. To make a change the user selects 
the new rating he wants and then clicks on the “Send Rating” box.

Note: If the CPC password protection feature is being used, the user will be asked to enter the 
proper password (or passwords) before this change will be sent to the module.
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Real-time Clock Panel – In early CPC hardware the real time clock was not set at the 
factory but could be changed manually. CPC production intent hardware has the time set 
to GMT as part of production process. Production electronic tools will display the time and 
date stamp data based on the local PC time zone.
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The “Activate Outputs”
Service Tab works with 
outputs from both the 
MCM and CPC.

The appearance in the 
main workspace will 
change depending 
upon which group of 
outputs you are 
working in.

In the example of the 
CPC analog gauge 
outputs the user may 
set a desired output 
percentage, and initiate 
start / stop commands, 
but not set a duration 
for the commands.
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In the example of 
the CPC digital 
outputs by function, 
the inputs may only 
be turned on or off. 
The are no 
percentages or 
duration settings 
available.
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The MCM digital outputs 
section  (to control engine SW 
functions) allows the user to:

- Turn the switch function on 
or off

- Set the duration of time the 
desired.switch is on 

Note: At this time the user 
needs to go view the MCM par 
file to properly identify the 
PWM and Switch settings for 
the specific engine being 
worked with.
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The MCM analog outputs 
section  (to control engine 
PWM functions) allows the 
user to:

- Set a percentage of the PWM 
output.

- Set the duration of time the 
percentage is desired.

- Start and Stop the function

Note: At this time the user 
needs to go view the MCM par 
file to properly identify the 
PWM and Switch settings for 
the specific engine being 
worked with.
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C1 – Compression Test  
- For all engine types 
from 7.3.3.5 and higher 
levels of software with 
the proper fuel map 
configuration. This will 
vary with wide variety of 
test software currently 
in the field but will be 
available for production 
vehicles.

The test measures 
relative compression of 
all cylinders based on 
cylinder with the “best”
compression.

To begin the test click 
on the “Run Test” box 
(1) in the lower right 
and follow the 
instructions that follow.
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The DPF Regeneration tab 
allows the user to start a 
manual regeneration of the 
after treatment device, monitor 
the values of key after 
treatment system components 
while the test is in progress 
without leaving the service 
routine screen, and stop the 
process for any reason once it 
has begun by selecting the 
“Stop Request” box.

To initiate the command to 
start the Regen process the 
user must complete all the 
necessary safety checks (see 
the After Treatment 
Technician's Guide for details). 
The “Start Request” box will 
become active and the 
process may be started..

Note: A regen process begun 
by the DDDL 7.0 tool will be 
terminated if the tool is 
removed from the vehicle 
diagnostic connector.
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3 and 5 Sensor 
Voltage Routines 

To begin 
monitoring the 
sensor voltage 
values, click on 
the “Start 
Acquiring” box. 

At this time you 
must use the pin 
chart to clearly 
identify the 
values.displayed.

Please note not 
all values on the 
tab will be 
configured on 
every vehicle.
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The Turbo Actuator Service Tab
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The S-60 production turbocharger has an electronic actuator 
controlled by the MCM via CAN communications. There are 3 service 
routines that are used for installing and diagnosing the electronic 
actuator.

1) The Pre-Alignment test – rotates the output gear to coincide with the nozzle 
position   Note:This test must never be run with the actuator mounted on the 
turbo.

2) The Self Calibration test – enables the actuator to memorize the turbo end 
stops

3) The Scan test –checks for free nozzle movement 
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Running the Pre-Installation 
Routine
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The pre-installation 
routine is run on the 
actuator prior to 
installation on the 
turbo.

Connect the 
actuator to vehicle 
harness.  

With DDDL 
connected through 
the vehicle’s 
diagnostic 
connector,go to the 
“Turbo Actuator”
tab of the “Service 
Routines” section.

Select the “Pre-
Installation” box in 
the lower left of the 
screen.
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Follow the 
instructions in 
the upper half 
of the screen. 
Click on the 
“Next” box in 
the lower right 
to proceed.
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To begin the 
routine click on 
the “Start” box 
in the lower 
right of the 
screen.
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Once the 
routine is 
started the 
progress is 
tracked in the 
lower half of 
the screen. 
The movement 
of the gear will 
be audible as 
the function is 
completed. 
The function 
takes only a 
few seconds to 
run.
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When the routine 
has finished the 
results will 
appear 
automatically. 
The user will see 
a check mark in 
the upper half of 
the screen and a 
message saying 
the test was 
successfully 
completed in the 
lower half of the 
screen.

To move on the 
next step select 
the “self 
Calibration” box 
in the lower left.
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If the test fails the 
top half of the 
screen will alert 
the user with an 
“X” in the graphic 
and the text at the 
bottom of the 
screen will give 
more details on 
the nature of the 
failure.
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Running the Calibration Routine



©
20

06
 D

et
ro

it
 D

ie
se

l C
or

po
ra

ti
on

 a
nd

 T
ec

hn
ic

al
 S

up
po

rt
.  

A
ll 

Ri
gh

ts
 R

es
er

ve
d.

 F
ile

na
m

e/
6/

6/
20

08

122

2007 Electronic Tools for DDEC VI

Follow the on-
screen instructions 
for installing the 
actuator properly on 
the turbo. Make 
sure you have all 
the correct pieces 
from the installation 
kit. The kit should 
contain mounting 
bolts, alignment pin, 
and grease. 

Select “Next” when 
you are ready.
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Follow the on-
screen 
instructions to 
align the 
reference holes 
and select 
“Next” when 
finished
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You may now 
mount the 
actuator. Make 
sure the new 
gasket is 
properly 
aligned during 
the installation 
and the 
mounting bolts 
torqued to 
proper 
specifications.

Once the 
actuator is 
securely 
installed select 
the “Next” box.
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To begin the 
routine click on 
the “Start” box 
in the lower 
right of the 
screen.
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When the routine is 
finished the results will 
appear automatically. 
The user will see a 
check mark in the 
upper half of the screen 
and a message saying 
the test was 
successfully completed 
in the lower half of the 
screen.

If the test fails there will 
be a black “X”
displayed in the graphic 
in the upper portion of 
the screen and 
descriptive test in the 
lower half of the screen.
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Note: The Scan test is still being implemented and will be 
documented at a later time
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A Step by Step Look at the 
Cylinder Cutout Routine
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The Cylinder Cut Out Routine
- This section will document the procedure using the cylinder cutout 

test to help diagnose a faulty cylinder with DDDL.
- DDDL offers users the choice of running the automated cylinder 

cutout test (running at 1000 RPM) or allows the user to manually
run the test.

- The cylinder cutout test has special tabs in the “Service Routines”
section.

- It is recommended that a new diagnostic session be initiated to 
begin a new log file.  

- It should be noted that cylinders are identified by position within 
the 2007 electronic tools and not by firing order.
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We’ll begin by 
reviewing the 
procedure for the 
automatic 
cylinder cutout 
test. 

The automatic 
test currently 
cuts out one 
cylinder at a time 
in physical 
sequential order.

To begin the test 
click on the “Run 
Test” box.
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We are now viewing 
the screen as it will 
appear during an 
automatic cutout 
test.
The actual torque 
value rises each 
time a good 
cylinder is cut out 
to compensate for 
the torque loss.
Cutting a bad 
cylinder will not 
change the actual 
value. 
The window below 
the chart gives the 
status of the test as 
it moves forward.  
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When the test is 
complete you’ll 
informed in the 
status window 
below.

The numerical 
results of the 
test are 
displayed 
completely at 
that time. The 
complete 
results may 
also be viewed 
graphically. 
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You may also go 
the tab for 
performing a 
manual cylinder 
cutout and 
manually run 
the test. You 
need to go to 
the workspace 
in the lower 
level of the 
screen. You will 
be able to select 
the cylinder and 
issue the 
instructions in 
manual mode.  
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You must use the manual mode to cut out more than one cylinder at a time 
in Drumroll. You may cut out up to 3 cylinders at a time. It is recommended 
that mated pairs be cut out (1,6 / 2/5, 3/4) as a first step in the multiple 
cylinder testing. The shot above is from a test where pairs were cut out. 
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XI. Understanding Electronic 
Tools Configuration Settings
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This section covers how to customize important settings in 
the 2007 electronic tools:

1- How to change from one translator box to another

2- Users may now select between metric and English units of 
measure

3- Customizing the display settings for the “Chart” feature

4 – How to change the settings for the automatic or manual 
connection settings

5 - How to set up a connection to the DDC reprogramming 
server for DDRS users
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When changing from using one translator box to another you must 
change the translator type in DDDL.
From the main screen of Windows, go to “Start”, “Programs”, “Detroit 
Diesel”. Choose the “SID Configure” option.   
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A new window will appear 
giving you a list of all the 
choices that you may pick 
from. Choose the translator 
box that you want (1) and 
then choose “OK” (2). Your 
new selection will work the 
next time you open the 
application. 

Special Note: The number of 
devices that appear in this 
window will vary with the 
number of translator box 
software drivers you have 
loaded on your computer.



©
20

06
 D

et
ro

it
 D

ie
se

l C
or

po
ra

ti
on

 a
nd

 T
ec

hn
ic

al
 S

up
po

rt
.  

A
ll 

Ri
gh

ts
 R

es
er

ve
d.

 F
ile

na
m

e/
6/

6/
20

08

139

2007 Electronic Tools for DDEC VI

Selecting Units of Measure
From the “Tools” drop-down menu 
select “Options”

Click on the 
“Units” selection 
in the options list 
and select the 
type of units you 
prefer (1), then 
select the “OK”
box to save your 
choice.
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A user may select different background color schemes 
and font sizes.
From the “Tools” drop-down menu 
select “Options”

Choose the 
“Display”
tab to reveal 
the choices 
available.
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You may 
choose from 
different color 
schemes and 
font sizes 
although it is 
recommended 
that the default 
theme and 50% 
text size be 
used.

Once you have 
made your 
selections click 
on the “OK”
box.
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You may alter the settings for making an 
automatic or a manual connection by going to 
the “Tools” drop-down menu,and selecting 
“Options”.

The settings 
may be 
changed on 
the 
“Support”
tab by 
checking the 
or checking 
the 
appropriate 
boxes,and 
applying the 
changes. 
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Configuring DDRS to connect to the DDC Programming Server

Special Note- In order to use this section you must have a current 
programming station ID and hardware key.

Selections without hardware key present Selections with  hardware key present

From the “Tools” drop-down 
menu select “Options”

Choose the “Server” tab to configure your settings.
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The settings that need to be configured in DDRS are similar to connecting with 
DRS. You may use your current ID, password, and method of connection 
(Internet or Frame Relay). For assistance with these settings call 313-592-5800.
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Support for 2007 Settings

Current DRS Connection Type:

DDC LAN Network

Distributor Frame Relay

Dial-up Accessing the Server Via Internet

Server Name: 148.99.32.62 Server Name: ddcapps.detroitdiesel.com

Port Number: 80 Port Number: 80

Use ACF2 Connection: checked Use ACF2 Connection: checked

User Name: Current DRS ID User Name: Current DRS ID
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Additional Miscellaneous 
Information
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Log files are automatically 
created whenever DDDL 7.0 
is connected to a live 
controller and stored on the 
hard drive. Over time these 
files may accumulate and 
need to be deleted to save 
hard drive space. The user 
may perform this process 
manually or he may 
automatically manage these 
files within DDDL.

Go to the “Tools” drop-down 
menu and selecting 
“Options” the user may 
access the “Support” tab 
and select settings to 
automatically delete log files 
after a given period of time.

Please note the default 
setting is “Never” so the 
feature will not work 
automatically unless 
configured by the user. 
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DDDL 7.0 offers the user a variety of 
options for printing the information 
contained in various windows of the 
program. The command to print may be 
accessed from the “File” drop-down 
menu (that also contains a “Print 
Preview” command) and from the 
printer icon in the icon bar.

The following items may currently be printed in DDDL 7.0:

- Information in the “Identification” window

- Information in the “Fault Code” window

- Troubleshooting Guide information

- Instrumentation (only the “All Instruments” list at this time

- Parameters 

Note: At this time Information from various service routine windows is not available for printing.
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